Learning Center

Whether or not you’re familiar with the Mac OS, if you've
used a personal computer, you likely already know
enough to start using Mac OS X. In Mac OS X, you'l
find familiar items—such as menus, icons, windows,
and folders—that make it easy for you to get started
right away. You’ll also find many enhancements that
make working with a Mac easier and more enjoyable
than ever.
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Take a Look at the Finder
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The Mac OS X desktop is what you’ll see when you start up your computer. The
desktop is part of an application called the Finder. The Finder is the primary way
of accessing, organizing, and managing your files and applications in Mac OS X.

With the Finder, you have quick and easy access to all your applications and

files. The left side of every Finder window contains the Sidebar, allowing you to
quickly access the applications and files you use the most.

Take a Look at the Finder



Try It Learning Center

Take a Look at the Finder

Practice using the Finder

1 Go to the File menu, and then choose New Finder Window. Notice the window
contains the contents of your home folder.

2 Click the Applications folder to see all the applications that come with Mac OS X.

3 Insert a CD and notice how a CD icon appears in the Sidebar at the left of the
Finder window.

4 Click the eject icon to the right of the CD to eject it.

5 In the toolbar at the top of the Finder window, click the column view button to
change the way the Finder displays your files.

6 Click the green button in the upper-left corner of the window. Notice how the
window resizes.

7 Click the red button to close the Finder window.

Take a Look at the Finder
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Take a Look at the Finder

Use the Action button to perform a variety of tasks

With the Action button in the Finder window toolbar, you can archive a folder, get
information about a file, or even create a new folder—all with just a click of the mouse.
You may have different options depending on the item you have selected.

Resize Finder windows to meet your needs

You can use the lower-right corner of a Finder window to adjust its size. You might want
to adjust a Finder window’s size to show more folders, or to fit more windows on your
desktop. As you use other applications you’ll find that most windows can be resized by
using the same corner.

Choose how you view your files

Use the three buttons in the Finder window toolbar to change the way the Finder displays
your files. You can choose between icon view, list view, and column view. Icon view
displays all of your files as icons; list view gives you quick access to additional
information about files; and column view makes it easy to see the path to each file.

Use the window controls to close, minimize or resize windows

The three buttons in the upper-left corner of every Finder window are known as the
window controls. The button on the left closes the Finder window (but not the Finder); the
middle button minimizes the window; and the button on the right resizes the window.
These three buttons are similar to the three buttons used by Microsoft Windows on a PC,
and the window controls in Mac OS 9.

Change the width of the Sidebar

You can move the bar between the two sides of the Finder window to redistribute space.
Place your pointer over the separator bar and you’ll notice the pointer changes. Click the
bar and drag it from one side to another to change the width of the Sidebar. As you use

other applications, such as Mail, Address Book, and iCal you’'ll notice a similar interface

for resizing columns in applications.

Take a Look at the Finder
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Get Familiar with the Dock
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You can use the Dock for one-click access to the applications and files you use
most. You'll find the Dock at the bottom of your screen. It contains several useful
applications you'll likely find yourself using frequently.

You can also use the Dock to quickly see which applications you have open.
Every open application appears in the Dock with a small black triangle below it.

Get Familiar with the Dock
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Get Familiar with the Dock

Practice using the Dock

1 In the Finder, choose Applications from the Go menu.

2 In the Applications folder, double-click the TextEdit icon to open TextEdit. Notice
how the TextEdit icon bounces in the Dock while TextEdit opens.

3 Click the Safari icon in the Dock to open the Safari web browser. You'll now have
two applications open.

4 Notice how the open applications have black triangles below their icons in the
Dock.

5 Switch between these open applications by clicking their icons in the Dock.

Get Familiar with the Dock
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Get Familiar with the Dock

Control-click on items in the Dock to control them or get more information

You can Control-click or click and hold any item in the Dock to get a contextual menu
that will allow you to do a variety of tasks. For example, Clicking on the iTunes
application, with iTunes open, will allow you to play or pause a song, rate the currently
playing song, or close the application. Clicking a folder in the Dock will allow you to view
the folder’s contents in a menu.

Add and remove applications, files and folders

It's easy to add and remove items from the Dock. You can add an item to the Dock
simply by dragging it from a Finder window to a position on the Dock. Applications will go
on the left side of the Dock, while files and folders will go on the right side. You can also
add a running application permanently to the Dock by clicking the icon in the Dock and
choosing Add to Dock. To remove an item from the Dock drag the icon off the Dock or
click the icon and then select Remove from Dock.

Change the location and size of the Dock

Control-click the divider line in the Dock to get a contextual menu that will let you turn on
and off hiding, change the position of the Dock and even turn magnification on and off.
This can be useful with computers with small screens.

For Mac OS 9 users

In Mac OS X, you use the Dock to switch between open applications the same way you
used the Applications menu (in the upper-right corner of the screen) in Mac OS 9. The

icons that appear in the Dock when you install Mac OS X are similar to the aliases that

were installed on the Mac OS 9 desktop.

For PC switchers

You may notice that the Dock works similarly to the Taskbar on your PC. Like the
Taskbar, the Dock allows you to access your favorite applications quickly.

Get Familiar with the Dock
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Organize Files in Your Home Folder
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You may frequently save files to your desktop for convenience. Over time, this
may make finding the right file difficult. To stay organized, and be able to find
just the right file when you need it, you may want to move your files into folders.

Your home folder contains folders for your movies, pictures, music, and

documents, for example. If you find that you need more places to store your files,
it’s easy to create more folders.

Organize Files in Your Home Folder
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Organize Files in Your Home Folder
Create a new folder and move a file from your desktop to the new folder

1 Click the Practice Files item in the Sidebar of the Finder window and then open
the Documents folder.

2 Drag the three files in the Documents folder to your Desktop.

3 Click the Documents folder in the Sidebar, go to the Finder menu and then
choose New Folder.

4 Name the new folder Projects.
5 Drag the three practice files from the Desktop to the Projects folder.

g6 Click the Practice Files item in the Sidebar of the Finder window and then open
the Pictures folder.

7 Drag all of the files to the Pictures folder in the Sidebar.

Organize Files in Your Home Folder
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Organize Files in Your Home Folder

Applications help keep you organized

Many applications in Mac OS X have been designed to automatically save files in one of
the folders in your home folder. For example, by default, TextEdit saves files in your
Documents folder, iTunes stores your music in the Music folder, and iPhoto keeps your
digital pictures organized in your Pictures folder.

Only you have access to the folders in your home folder

With the exception of the Public and Sites folders, only you have access to the contents
of the default folders in your home folder. To prevent your files from being accessed by
other users of the computer, store your files in one of the default folders in your home
folder. It’'s easy to add sub-folders within each of the folders in your home folder. From
any folder, go to the File menu and choose New Folder, or press Command-Shift-N on
your keyboard.

What is the Desktop Folder used for?

The Desktop Folder contains items stored on your desktop. These items are not
duplicated; your desktop and the Desktop Folder are just two ways to access the same
items. This can be convenient when you have several files on your desktop and want to
sort them, or drag them into an application’s window that is covering the items on the
desktop.

Watch for visual clues when dragging files

When dragging files from one folder to another, watch how the icon changes. If the icon
displays a plus sign, the file is being copied. If it displays a small arrow, an alias is being
created. If the icon’s appearance doesn’t change, the file is being moved. It’s easy to
override the default behavior when dragging a file from one place to another. Hold the
Option key to copy a file that would normally be moved. If you want to move a file that
would normally be copied, hold the Command key.

Use the Sidebar to organize your files

You can use the Sidebar at the left of a Finder window just as you would a folder. You
simply drag a file or folder to an icon in the Sidebar to move the file or folder to that
location.

Organize Files in Your Home Folder
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Configure Settings for Your Computer
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There are many ways you can customize your Mac to suit your working style.
You might want to change what the clock looks like, how the computer responds
when a CD or DVD is inserted, or even the alert sounds your Mac makes, for
example.

All of these settings are easy to find because they’re all in one place: System

Preferences. With System Preferences, you can customize almost every aspect
of your Mac to work just the way you want it to work.

Configure Settings for Your Computer
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Configure Settings for Your Computer
Take a look at System Preferences

1 From the Apple menu, choose System Preferences.
2 In the window that appears, notice all the preferences that are available.
3 In the Hardware category, click the CDs & DVDs icon.

4 Notice how the System Preferences window changes to show the CDs & DVDs
preferences pane. This is where you can change how Mac OS X behaves when a
CD or DVD is inserted.

5 Click the Show All icon in the upper-left corner of the window to return to the
main System Preferences window.

6 Select a few of the other preferences and notice the settings you have access to.

Configure Settings for Your Computer
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Configure Settings for Your Computer

Change how preferences are sorted

To find what you're looking for more quickly, go to the View menu. There you can
choose to arrange system preferences by category or alphabetically.

Lock preferences to prevent accidental changes

Some system preferences can be locked to prevent other users from changing them.
Changing locked preferences requires an administrator password. This can be useful if
several users use the same computer, or for preventing you from accidentally changing a
setting.

Some preferences can be added to the menu bar

Some system preferences can be added to the menu bar for fast and easy access.
International, Displays, and Classic preferences are just a few that you can add to the
menu bar.

Find the right System Preference without guessing

The search field in System Preferences will help you find just what you need. Start typing
a word or phrase and you’ll see several preferences highlighted. The more you type, the
fewer preferences are highlighted. System Preferences will also search for preferences if
you use Microsoft Windows terms. For example, type the word “wallpaper” and the
Desktop & Screen Saver preference is highlighted.

Configure Settings for Your Computer
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Find Files on Your Hard Disk Using Spotlight
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Have you ever lost a file, contact, song, or even an email message on your
computer? With Spotlight, you can search for and find almost anything on your
computer from one convenient location.

Type a search term in the Spotlight field, and the results are gathered from

Finder, Mail, Contacts, and many other locations and applications. And since
Spotlight categorizes your results, you’ll find what you’re looking for fast.

Find Files on Your Hard Disk Using Spotlight
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Find Files on Your Hard Disk Using Spotlight
Search your computer with Spotlight

1 Click the Spotlight icon in the upper-right corner of the menu bar, and then type
WWCT.

2 Notice the files that appear on the list.
3 To see more files, choose Show All to open the Spotlight window.

4 Ifonly 5images are displayed, click the “5 more” link below the images to view
them.

5 Double-click any file to open the file.

Find Files on Your Hard Disk Using Spotlight
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Find Files on Your Hard Disk Using Spotlight
Use the Spotlight window

The Spotlight window delivers your results so they are easy to read. Use the disclosure
triangles next to the group headings to expand or collapse a section. Only the five most
recent matches are displayed, so that you’re not overwhelmed by a huge list of results.
You can click the “more” link to see the entire list of results in that group.

Narrowing your searches

When Spotlight finds a long list of results, you can narrow your search by location and
date. Click Show All from your list of results, and then choose a smaller date range under
the “When” category, and choose a different location from the “Where” category.

Getting more info in the Spotlight window

In addition to being able to change the grouping and sort-type of your search results, the
Spotlight window gives you good information about the items you’re looking for. Click the
Information icon next to an item in the list, and you’ll see additional details without having
to open any extra applications.

Use the built-in slideshow in Spotlight

When images are returned in your search results, you can click the Play button to see a
full screen slideshow of your pictures. Sometimes digital cameras format the date into
your photo’s filename, so you can do a search on a date, such as “April 29, 2005” to see
all of the pictures that you took on that day.

Changing the order in which the spotlight results are displayed

In the Spotlight system preference window, click Search Results and notice the list of
categories that appear in your search results. You can drag categories to change the
order in which results appears. If you don’t want Spotlight to display results in certain
categories, just deselect the checkbox next to that item.

Using privacy settings
In the Spotlight system preference window, click the Privacy tab. Drag any folder or disk

into the list to prevent Spotlight from searching the location. This is great if you have
more than one hard drive or a partitioned hard drive that you don’t want indexed.

Use your keyboard to search with Spotlight
By default, holding down the command key then pressing the space bar on your
keyboard will open the Spotlight menu. Holding down the command and option keys while

pressing the space bar will open the Spotlight window. You can customize Spotlight to
work with other key commands in the Spotlight System Preference window.

Knowing when Spotlight is updating

Spotlight finds files quickly because it indexes the contents of your hard drive. You'll



know when Spotlight is indexing your computer, because you will see a small circle pulse
inside the Spotlight icon on the menu bar. While Spotlight is indexing, you will not be able
to use the Spotlight menu. However, you’ll be able to search in the Spotlight window.

Find Files on Your Hard Disk Using Spotlight
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Search your Mac from a Finder Window
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Do you have different types of files stored in various locations on your hard disk,
such as music files, movies and text documents that you’d like to be able to
access all at once? Because Spotlight search technology is built into the Finder
you can search your Home folder, your entire computer, and even your network
quickly and easily.

With Spotlight built into the Finder, you can quickly perform a search right from

the Finder window, and then save the results as a Smart Folder so you can
quickly access all the files in one location.

Search your Mac from a Finder Window
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Search your Mac from a Finder Window
Create a Smart Folder

1 Open a Finder window and type WWCT into the Search field.

2 Refine your search by choosing whether you would like to search your Home
Folder, your whole computer, or a server.

3 To refine the search even further, click the + button on the right side of the Finder
window and then choose additional search criteria.

4 When the Search results contain all the files you want, click the Save button to
create a Smart Folder, name the folder Practice Files, and then click Save.

5 You can now quickly access this specific search criteria in the future from any
Finder window.

Search your Mac from a Finder Window
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Search your Mac from a Finder Window

Search in different locations

You can narrow your search to a specific folder by clicking the Others button. In the
sheet that appears either drag a folder in or click the + button to add a folder. If you don'’t
want a folder to be searched, but don’t want to remove it from the list, you can deselect
the box to the left of it to exclude it from the search.

Change how you view Search results

By default your search results are displayed as groups, so you can quickly see all files of
the same type together. You can change how you view your search results to List view
or lcon view by using the view buttons in the Finder toolbar.

View a slideshow from a search

If your search results include image files you can view a slideshow of these pictures by
clicking the play button on the right side of the Images row. Move the pointer and you
can view a contact sheet of all the images, manually move back and forth between the
images, resize smaller images to fit the screen, or close the slide show.

Get more information on a file

If you want to see more information on a file, including a preview for certain types of files,
click the information icon on the far right side of the Finder window on the same row as
the file. This will give you basic information on the file, such as the file type, size and
when it was created and modified. To hide the info on the file, click the arrow icon that
appears when the information is showing.

View the full path to a file

If you want to know exactly where a specific file is on your hard disk, select itin the
search window. At the bottom of the Finder window you’ll see the full path to the file.
Double-click the file at the bottom of the window to open it, or double-click any folder in
the path to open itin a new Finder window.

Edit a Smart Folder

If you ever want to edit a smart folder to include or exclude files, open the Smart folder
and then click the Edit button. From there you can change where to search, what to
search for and you can even add and remove search criteria, just as you would when
creating a Smart Folder.

Delete a Smart Folder

By default, Smart Folders are stored in the Saved Searches folder inside your Library
folder, as well as in the Sidebar. Removing the Smart folder from the Sidebar will not
delete it from your hard disk. If you want to completely remove the Smart folder, go into
the Saved Searches folder and drag the Smart Folder to the Trash.

Search your Mac from a Finder Window
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Customize the Finder to Meet Your Needs
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Because the Finder is an application, you can configure its settings by choosing
Preferences in the Finder application menu. For example, you can set the Finder
to control which icons appear on the desktop or in the Sidebar of Finder
windows.

You can also use Finder Preferences to control whether folders open in a new
window or the same window, set windows to always open in column view, and
adjust settings for spring-loaded folders.

Customize the Finder to Meet Your Needs
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Customize the Finder to Meet Your Needs
Make changes to what is displayed on the desktop and in the Sidebar

1

With a Finder window open, choose Preferences from the Finder menu.

Click the General icon in the toolbar, and then deselect the "Hard disks" option.
Notice how the hard disk disappears from the desktop.

In the Finder window, drag the Public folder from the main part of the Finder
window to the lower part of the Sidebar. Notice how the other icons in the Sidebar
adjust to fit the new item.

Drag the Public icon up and down in the Sidebar, and notice that you cannot drag
it above the separator line.

Drag the Public icon out of the Sidebar, and watch it vanish in a puff of smoke.

Customize the Finder to Meet Your Needs
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Customize the Finder to Meet Your Needs

Quickly see how many items a folder contains

If you want to know what a folder contains before looking in it, make sure you’re in Icon
view, go to the View menu, choose Show View options, and then select the “Show item
info” option. This will display the number of items in the folder below the folder name. It
will also display the dimensions of a picture file, the length of a song or movie, and more.

Preview your digital photos in the Finder

You can easily use the Finder to quickly view your digital photos. If you have a folder that
contains several picture files, make sure you’re in Icon view, go to the View menu,
choose Show View options, and then select the “Show icon preview” option, and then
set the icons to the maximum size. This will give you a good overview of all the digital
photos in the folder.

Keep Finder windows tidy

If you want to keep items in your Finder windows neat and orderly, make sure you’re in
Icon view, go to the View menu, choose Show View options, and then select either
“Snap to grid” or “Keep arranged by.” The “Snap to grid” option keeps all of your icons in
neat rows and columns, whereas “Keep arranged by” keeps everything organized by
name, date, size, kind, or label.

For Mac OS 9 users

If you want to Mac OS X to behave more like Mac OS 9, select “Always open folders in a
new window” in the General pane of Finder Preferences. Then, every time you double-
click a folder in a Finder window, it will open in a new window.

Customize the Finder to Meet Your Needs
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Use Dashboard to access information quickly
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Dashboard

Have you ever needed to quickly look up the address of a friend, or do a quick
calculation while you are working on your Mac? Dashboard instantly opens small
applications, called widgets, without interrupting your workflow. Press F12 to see
your contacts, calendar, calculator, dictionary, and more.

Imagine having a language translator appear just as you need help typing a
document in another language. Or being able to quickly use the calculator, and
copy and paste the result into an email. Dashboard puts the information you
need at your fingertips.

Use Dashboard to access information quickly



Try It Learning Center

Use Dashboard to access information quickly
Open Dashboard and use the clock widget

1 Open Dashboard by clicking the Dashboard icon in the Dock. Notice that a semi-
transparent layer appears over your Desktop.

2 To make changes to the Clock widget, move your pointer over the clock, click the
information icon in the bottom-right corner and notice the widget flip.

3 Choose your Continent and City from the pop-up menus.
4 When you’re ready, click Done.

5 To move the Clock to another location click anywhere on the clock and simply
drag it where you want it.

6 When you're finished using Dashboard, click anywhere outside a widget to return
to your Desktop.

Use Dashboard to access information quickly
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Use Dashboard to access information quickly
Open the Dashboard bar

To use a widget that isn’t already open, click the + icon in the bottom-left corner of the
screen to open the Dashboard bar. You'll have access to every widget installed on your
computer, as well as a way to get more widgets. Click the icon again to return to using
your Dashboard widgets.

Open a widget by clicking or dragging

After you open the Dashboard bar you have the option to click or drag a widget to use it.
If you click a widget it will open up in the center of the screen. From there, you can drag it
to any location on the screen. If you would like a widget to open from a certain place on
your screen, just drag the widget to that location from the Dashboard bar.

Working with the built-in widgets

When you first open Mac OS X you will have several built-in widgets. These widgets can
help you track your stocks, check the weather report, look up words in the built-in
dictionary, and even check your flight status.

Using the “i” to change widget information

Some widgets have an “i” icon that becomes active when you roll your cursor over it.
Clicking this icon lets you customize the widget to your specifications. For example,
clicking the “i” on the Weather widget lets you set your location. Clicking “i” on the Stocks
widget lets you select which company’s quotes you want to see.

Adding and removing the Dashboard icon in the Dock

By default, the Dashboard icon is in the Dock and always running. If you prefer to access
Dashboard with key commands you can remove the Dock icon by dragging it off the
Dock, or by clicking and holding the Dashboard icon and choosing “Remove from Dock”
from the menu that appears. To add Dashboard back to your dock, go to the Applications
folder and drag the Dashboard icon to the Dock.

Customizing the key commands for Dashboard

By default, you can activate Dashboard by pressing the F12 key. If you want to change
the key command, open System Preferences and click Dashboard and Exposé. In the
panel that appears, change the Dashboard pop-up menu to a function key of your
choice.

Where to go to get more widgets

If Dashboard isn’t open, just click and hold the Dashboard icon in the Dock and then
choose More Widgets from the menu that appears. If Dashboard is open, open the
Dashboard Bar by clicking the “+” in the lower-left corner of the screen, and then click the
More Widgets button. Your browser will open to the Dashboard website where you’ll find
additional widgets that you can install.
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Back Up Important Files
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The more you use your Mac, the more files you’ll store on your hard disk. The
more files you store on your hard disk, the more important it becomes to back up
your data just in case you unexpectedly lose your data.

Mac OS X has a built-in way for you to quickly archive your important data,
whether you want to archive a simple document or all the music you’ve
downloaded from the iTunes Music Store. You can easily save these archives on
an external hard disk or your iDisk, or you can burn them to a CD or DVD.

Back Up Important Files
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Back Up Important Files

Make an archive of a folder and burn itto a CD

1

From the Go menu, choose Home.

Select your Documents folder, click the Action button in the toolbar, and then
choose the Create Archive option from the menu that appears.

Notice that this creates a file named Documents.zip in your home folder. You can
copy this file to another folder, email it to a friend, or burn it to a CD or DVD.

Insert a blank CD, name it Backup CD, and then drag the Documents.zip file to
the Backup CD icon in the Sidebar.

When you’re ready, click the Burn icon to the right of the Backup CD.

Double-click the Documents.zip file in your home folder to expand it. Notice that
the file disappears, but a Documents 2 folder appears. The contents of the
Documents 2 folder are identical to those of the original Documents folder.

Back Up Important Files
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Back Up Important Files

Create a Burn Folder

If you have several files you want to burn to a CD or DVD, but don’t have a disk
available, you can create a burn folder to collect your files and burn the disk later on. To
create a burn folder, go to the File menu and choose New Burn Folder. Drag the files or
folders you want to burn to a disc to the Burn Folder, and then when you’re ready to
burn a CD from the Burn Folder, simply insert a CD or DVD and press the Burn button in
the upper-right corner of the Burn Folder.

Restore files from a backup archive

To restore files from an archive, simply double-click the archive file. A folder will appear
with the name of the archive. If a folder with that name already exists a number will be
appended to the end of the folder name. All your files will be inside the folder. Drag your
files to the location you want them, and delete the folder and archive file when you no
longer need them.

Store backups anywhere

Once you create an archive file you can treat it like any other file. Storing the file on a
FireWire hard disk is a good way of storing your archives so you can get to them quickly
when and if you need them. You can also email these files to friends and family
members for them to use, or store for you in a safe place in case you ever need them.

Back Up Important Files
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Use the Trash
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Eventually, you may find that you have files or folders you no longer want. For
example, if you downloaded an installer file for a new application and have
installed the application, you no longer need the installer file. To save space on
your hard disk, you can delete the installer file.

With Mac OS X, you can put files in the Trash when you don’t need them
anymore. These files are stored there until you empty the Trash. If you decide
that you actually do need the file, simply drag it out of the Trash.

Use the Trash
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Use the Trash

Practice using the Trash

1 Do a spotlight search for WWCT Practice Files.
2 Drag the Useless File for the Trash file to the Trash icon in the Dock.

3 Fromthe Finder menu, choose Empty Trash.

Use the Trash



Learn More

Learning Center

Use the Trash

Use Secure Empty Trash to permanently remove a file

With Mac OS X, you can securely delete files to make sure that nobody will ever be able
to retrieve the data from your hard disk. Even if you empty the Trash, the data that was
there can still be retrieved with special software. Choosing Secure Empty Trash from the
Finder menu makes it impossible for any special software to retrieve the data.

Undo your last action

In many applications, including the Finder, you can take back the last action you
completed by choosing Undo from the Edit menu. This option can be handy if you
accidentally put a file in the Trash or move a folder to the wrong location.

Use the keyboard to quickly delete a file

Hold down the Command key while pressing the Delete key to send a selected file to the
Trash. This can be faster than dragging files to the Trash. You can also empty the trash
by pressing the Command, Shift and delete keys, or by holding the Control key and
clicking the trash icon in the Dock.

For PC Switchers

The Trash on your Mac is the same as the Recycle Bin on your PC. However, deleting
items from an external device such as a Zip drive works a little differently on your Mac.
When you delete an item from an external device, it is moved to the Trash, but does not
create more space on the external device until you empty the Trash with your external
device connected to your computer.

Why some files can’t be removed from the Trash

If a file is in use by an application it cannot be removed from the trash until it is no longer
being used. If you see a message that says “This operation cannot be completed
because the item is in use.” check to see if you have any open files, or if you accidentally
put a file in the Trash that you didn’t want to.

Use the Trash
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When you’re done working, it’s best to shut down your Mac, especially if you're
not going to use it for a while. If you forget to shut down your Mac, by default it
eventually goes to sleep to conserve energy. Sleep is a low-power mode that
makes the computer appear as if it is powered off, while preserving your work.

Your Mac has several built-in features for conserving energy. For example, if you
know that you’ll be working on your Mac only between the hours 8 a.m. and 5
p.m., you can set it to turn on automatically in the morning, and then turn itself
off at the end of the day.

What to Do When You’re Done Working
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Schedule your Mac to turn on and off automatically

1

From the Apple menu, choose System Preferences.

In the Hardware category, click the Energy Saver icon.

Click the Schedule button.

Select the "Start up the computer" option. Notice that you can now choose when
to start up the computer.

Click the checkbox to the left of the Shut Down pop-up menu. Notice that the
pop-up menu has two options: Sleep and Shut Down.

Set a time for the computer to shut down or sleep.

Click both checkboxes to deselect scheduling.

What to Do When You’re Done Working
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Set your Mac to sleep when it’s not in use
Instead of shutting down your Mac, you can set it to go to sleep when it’s not in use, or

manually put it to sleep by choosing Sleep from the Apple menu. This way, you can pick
up exactly where you left off.

Quickly put your Mac to sleep

In addition to choosing Sleep from the Apple menu, there are other ways to put your Mac
to sleep. If you'’re using an iBook or PowerBook, just close the display. If you'’re using a
desktop computer, press the power button on the display.

What to Do When You’re Done Working
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